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1. Unpacking and Inspection 
 
1.a. Checking the Package Contents 
The MDA-T5 is shipped with the components and cables indicated in the table below. Make sure that all components are included in 

 the shipping carton. Notify One Stop Systems if components are missing. 

 
 

Components Shipped with the MDA-T5 
 

Description  Quantity  

 
Serial Cable and DB9 Adapter 

 
2 each 

 
Drive pack, removable (some configurations have drive packs shipped separately) 

 
2 each  

 
Quick Start Guide, MDA -T5  

 
1 each  

 
Cable, power (for use in North America only) 

 
1 each  

 

1.b. Inspection 
 
After unpacking the unit, examine the MDA-T5 for: 

• Verify model and serial numbers on the barcode stickers match the information on the MDA -T5 invoice. 

• Bent, scratched, or missing pins on the connectors. 

• Rust, discoloration, or signs of corrosion or water, moisture, or chemical damage. 

• Drive packs that are cracked, scratched, or dented, and which do not smoothly slide in and out of their drive ports. 

 
 
*All trademarks ™ are the property of their respective owners. 
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2. Component Identification 
 
2.a. Description 
 

The MDA-T5 is a rugged, high-performance RAID storage chassis with two removable drive packs and dual Storage Bridge Bay 

(SBB) 2.0-compliant controllers. 

 
Features 

• Two easily removable drive packs, each pack holds six physical drives each capable of transporting up to 12TB of 
data for a total of up to 24TB. 

• Optional 1.5TB solid state drives for a total of 18TB 
• Hermetically sealed drive packs ensure operation to altitudes of 41,000 ft (12,496 m). 
• Rugged and fully field deployable in harsh environments 
• Sustained data transfer rates of over 300 MB/s per controller 
• Powered by RAIDCore RAID software technology 
• Two SBB 2.0 compliant RAID controllers 
• Thermal monitoring and control protects against extreme temperatures 
• Supports RAID levels 0,1,10 & 5 
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Drive Pack 1 Drive Pack 2 

 
 
2.b. Front Panel Components 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                        
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Descriptions of the Front Panel Components Table 

Component  Description  

Drive Pack 1, Drive Pack 2  
Each removable Drive Pack contains six disk drives or solid-state disks, a SATA/SAS 
backplane and a drive pack resistive heater.  Each drive pack is controlled by a RAIDCore 
SBB 2.0 RAID controller installed in the rear of the enclosure. 

DRIVE PACK 1 ACTIVITY 1-6  Each LED corresponds to disk drives 1 to 6 in Drive Pack 1. A disk drive’s LED is 
illuminated when the disk drive is performing data I/O operations.  

DRIVE PACK 2 ACTIVITY 1-6  Each LED corresponds to disk drives 1 to 6 in Drive Pack 2. A disk drive’s LED is 
illuminated when the disk drive is performing data I/O operations.  

STATUS - PACK 1  An illuminated LED indicates that the disk pack is installed, fully seated in the enclosure, 
powered-up and available for data I/O operations.  

STATUS - PACK 1  An illuminated LED indicates that the disk pack is installed, fully seated in the enclosure, 
powered-up and available for data I/O operations.  

SYSTEM  An illuminated LED indicates that the host computer is communicating with the MDA-T5.  

HEAT An illuminated LED is green when the system is powered and red when the heaters are 
on. 

SECONDARY POWER  Front access power is a secondary push button breaker that can be pushed to turn on 
and pulled to turn off.  Notice the white band when the power button is pulled off. 
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10/100 Ethernet port (J12) 

Unit Fans, 3 each 
 

Main AC 
Power 
On/Off 
Switch 
 

AC Power In 
Receptacle 
(J1) 
 

Host Interface Fiber Channel 
ports, Controller 2 (J10, J11) 

10/100/1000 
Ethernet 
port (J7) 

Host Interface Fiber Channel 
ports, Controller 1 (J5, J6) 

10/100/1000 
Ethernet port 
(J2)  

Reset Button Reset Button 

2.c. Rear Panel Components 
 
 
 
 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
Descriptions of the Rear Panel Components Table 

 
Component  Description  

Host Interface Fibre 
Channel ports; J5, J6, 
J10 and J11 

Accepts 8Gb Fibre Channel optical cables for connections between the MDA-T5 and a host computer.  
Uses a SFP to connect each port to an LC duplex optical cable. The Host Interface is a x8 PCIe 
personality module connected to each of the RAIDCore RC52xx SBB 2.0 RAID controllers.  Other 
personality modules are available for SCSI, PCIe cable, 1Gb Ethernet, 10Gb Ethernet or Infiniband. 

10/100/1000 Ethernet 
ports; J2 and J7 

Provides access for 10 Mbps,100 Mbps or 1000 Mbps data transfer speeds to each respective RAID 
controller via an RJ-45 connector 

10/100 Ethernet port; 
J12  

Provides access for 10 Mbps or 100 Mbps data transfer speeds to both RAID controllers via an RJ-45 
connector 

Unit Fans  Vents heat from the interior of the MDA-T5. The fan tray is removable to access the power supplies 
mounted inside the rear of the chassis.  

AC Power On/Off 
Switch Turns AC power on or off to the MDA-T5 power supply, raise to power the system on and lower to turn off. 

AC Power In 
Receptacle; J1 

Accepts cable for connection to a 100-240 VAC power source.  
WARNING: Prior to performing any maintenance on the MDA-T5, remove the AC power cable from 
its receptacle to ensure that all power is removed from the unit. 
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2.d. Set-up Requirements 
 
To setup, configure, and use the MDA-T5, the equipment operator must perform the following five operations in the order 

indicated in the table.    

   
   
   
   
  
 
 
 
 
 
 
 
 
 
 

 
2.e. RAIDCore RAID Controller Information 
 

 
RAIDCore RAID Controller Information 

 

Board type Bus Type 
Number of 
ports and 

type 
+12V  

Total 
Operating 

Power 
Dimensions 

Operating 
Temperature 

Range 

MDA-T5 
Controller SBB 2.0 16 

SATA/SAS TBD A  TBD W 
8-in (W) 

x10.7-in (L) x 
1.6-in   (H) 

-18° to  45°C 

 
SBB 2.0 compliant 

• SATA1 or 2 compliant  with Native Command Queuing 
• SAS compliant 
• >1GB/s Performance, up to 32 drives spanned 
• Phoenix adapters support SAS expansion 
• RAID levels 0,1,5,10,50 
• RoHS Compliant 
• Conformal coated 

 
2.f. System Information  
 

 
System Information 

 

Condition or Component Value or Range 

Controller Single or dual RAID controllers, supporting RAID levels 0, 1, 10, and 5. 

Performance Sustained data rates of over 300 MB/s per controller port 

Capacity HDD: Up to 12TB per drive pack, and 24 TB per T5 system 
SSD: Up to 9 TB per drive pack and 18 TB per T5 system 

Disk Drives 500 GB, 750 GB, 1 TB, 1.5 TB and 2TB SATA 

  
Sequence of MDA-T5 Setup, Configuration and Usage Table 

 

Operation  What to Do...  

1 Plan system configuration and usage (Type of RAID, size of arrays, ect.) 

2 Connect cables and establish data transmission connections  

3 Install a disk pack and perform other equipment setup  

4 Set up RAID configuration options 

5 Understand and use LED codes and functions  
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Host Interface 8Gb FC, 1Gb Ethernet, 10Gb Ethernet, PCI Express, Infiniband* 

 
 
2.g. Physical Information  
 
 

Physical Information 
 

Condition  Value or Range  

System Dimensions  19”w x 6.97”h x 24”d (483 x 177 x 606mm) 

Drive Pack Dimensions  8.2”w x 4.8”h x 11.2”d (208 x 122 x 285 mm)  

System Weight  65 lbs. (29.5 kg.)  

Weight per drive pack 
(with six drives)  15 lbs. (6.8 kg.)  

 
 
2.h. Environmental Information 
 
 

Environmental Information Table 
 

Condition  Value or Range  

Temperature (operating)  -18C to +45C; 0F to +113F 

Temperature (non-
operating)  -55C to +71C; -67F to +160F 

Altitude (operating)  
MIL-STD 810F Method 500.4 
0 to 41,000 Feet 
0 to 12.496 Meters  

Relative Humidity 
(operating)  6 to 95%  

Relative Humidity (non-
operating)  6 to 100%  

 
 
2.i. Environmental Testing Compliance  
 
 

Environmental Testing Compliance 
 

Condition  Designed to meet  

Shock  MIL-STD 810F Method 516.5 

Vibration  MIL-STD 810F, Method 514.5, Category 13, propeller aircraft 

Temperature and Humidity  MIL-STD 810F Method 501-503.4 

Salt Fog  MIL-STD 810F Method 509.4 

Explosive Atmosphere  MIL-STD 810F Method 511.4 

Emissions/Immunity  MIL-STD 461, CE101, CE102, CS114, RE101, RE102, RS103  
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2.j. Overview of RAID 
 
RAID Minimum Disk Requirements 
The following table lists the minimum number of disks required for each RAID level. 

 

RAID Level Minimum 
number of disks 

Maximum 
number of disks 

JBOD (Volume) 1 32 

RAID0 2 32 

RAID1 2 2 

RAID1n 3 16 

RAID10 4 32 

RAID10n 6 32 

RAID5 3 16 

RAID50 6 32 
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3. Hardware Installation and Configuration  
 
3.a. Overview 
 
The MDA-T5 is shipped with 19-inch rack-mounting hardware and Jonathan Engineered Solutions rack slides installed. Attach the 

MDA to the rack by screwing the fixed portion of the rack slides into the rack using the supplied rack slide mounting hardware.  

Then slide the chassis mounted portion of the rack slides into the mounted fixed portion. The chassis can be further fixed to the rack 

to prevent unwanted extension of the rack slides during missions by screwing the four front panel captive screws on the chassis 

rack ears into the rack-mounting angle near the front of the rack. For more information on the available rack slides or special 

mounting slides, please refer to the Jonathan Engineered Solutions web site at http://www.jonathanengr.com. 
 
 

3.b. Cabling the Unit 
 

Connectors, Switches, and LEDs 
Become familiar with the front and back of the MDA-T5. 

 
Cabling the Unit 
Cabling the MDA-T5 consists of making the following connections: 

• Fibre Channel (or other personality module interface) 

• Ethernet 

• Electrical power 

• Serial Port 

 
3.c. Fibre Channel connections compatible Fibre Channel host adapters 
 
Use only optical cables and associated SFPs. Do not use copper cables.  

 

 
Compatible 4-Port Fibre Channel Host Adapters 

 
ATTO  Celerity series  

 
 
 
 

 

 

 

• The MDA-T5 communicates with your computer by using a 8Gb Fibre Channel LC Duplex optical interface. A compatible 

host adapter must be installed in your computer for the MDA-T5 to communicate with the host computer.   

• To maximize the MDA-T5's 8Gb Fibre Channel interface, the host adapter in the computer should also be rated for 8Gb 

Fibre Channel. The 2Gb and 4Gb Fibre Channel host adapters will work, but at a lower transfer rate.   

• Make sure the host adapter is installed correctly, and that the appropriate host adapter drivers are installed and functioning 

properly, before connecting the MDA-T5 to the computer system. 

 
Compatible 2-Port Fibre Channel Host Adapters 

 
ATTO  Celerity series  

Qlogic  QLA Series  
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10/100/1000 
Ethernet connector 
for Controller 1 

10/100/1000 
Ethernet connector 
for Controller 2 

• Make sure the host adapter is installed correctly, and that the appropriate host adapter drivers are installed and functioning 

properly, before operating the unit. 

 

3.d. Fibre Channel I/O Connections 
 
An MDA-T5 with a Fibre Channel interface is shipped with a 8Gb Fibre Channel SFP (Small Form-factor Pluggable) optical 

transceiver. There is an LC Duplex hookup on Side A or Side B. The SFP mates to up to four LC Duplex optical cables for data 

transfer to and from the host computer, server, etc. 

 
To Install the SFP and Connect the LC Duplex Optical Cable 

1. Remove the protective cover from the SFP. 

2. With the gold contacts facing up, insert the SFP into FC Port 1.  Gently push the SFP in until it clicks.    
3. The tips of the LC Duplex cable are packaged with a protective covering. (The protector might be a cap over the white 

tips of the LC cable or a clipped-on shell). Remove the cover before use.  

4. Insert one end of the LC Duplex cable into the SFP at FC Port 1. 

5. Insert the other end of the LC Duplex cable into the Fibre Channel switch or Fibre Channel host base adapter of the 

host computer, server, etc.  

6. Repeat steps 4 and 5 for each port of the MDA-T5. 

 
Ethernet Connections 
Plug the Ethernet cable into connector into respective Controller Ethernet port or into the 10/100 port at the rear of the unit. 
 
  
 
 
 
 
 
 
 
 
 
 

10/100 
Ethernet 
connector 
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Electrical Connections 
1. Set the AC PWR switch to OFF. See Figure below. 

2. Connect a power cable at the rear of the unit, at AC PWR IN 

See Figure below Power Cable Connection.  Power cable connector, AC PWR switch 
 
 
 
 

 
 
 
 
 
 
 
 
3.e. Powering Up the Unit 
 

1. Power up the MDA-T5 by setting the AC PWR switch to the ON position. 

2. Push front panel breaker to ON position.  

3. Verify that the fans are running in each power supply and in the fan module. 

 
3.f. Scanning a SCSI Bus 
 
When a drive pack is removed from the MDA-T5, system-generated SCSI time-outs might cause the system to stop looking for 

storage available via the Fibre Channel interface.  To correct this situation, commands can be issued that prompt the system to 

“rediscover” the MDA-T5. The following examples illustrate the use of these commands on SGI IRIX systems and SUN Solaris 

Systems. 

 
SGI Irix 
On SGI IRIX systems, the SCSI bus can be scanned and the file system remounted, as shown in the following example: 

[Need an updated example, if applicable at all]. 

 
Sun Solaris 
On SUN Solaris systems, the SCSI bus may need to be rescanned and the file system remounted. To rescan the SCSI bus, refer to 

the following example: [need an updated example, if applicable at all] 

 

AC Power Switch 

Power cable  

Connector J1 
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Windows 2003 or XP 
Microsoft Windows 2003 or XP host systems can rediscover disk devices.  However, it is occasionally necessary to reboot. 

Windows can rediscover the MDA-T5 disk pack through either the Disk Administrator or Disk Part.  To access the Disk 

Administrator: 

1. Left-click on Start, then right-click on My Computer > Manage. 

2. Choose “Disk Management” under the “Storage” heading in the left tree hierarchy. 

3. From the Action menu, choose Rescan Disks. Windows updates the disks on the right side of the screen with information, 

including the recently inserted MDA-T5 device. 

 
 

3.g. Obtaining an IP Address 
 
There are two methods for obtaining the IP address of MDA-T5. The simplest is to have an IP supplied by the DHCP server on the 

network. The other requires assigning a static IP to the MDA-T5. 

 
DHCP 
 MDA-T5 configures to an IP address from a DHCP/BOOTP server on a network. If the network has such a server, power up the 

MDA-T5 and use the following instructions to find the IP address. 

1. Verify that the Ethernet cable is connected to MDA-T5 and to the network. 

2. Power up the system and wait for the power-up cycle to finish. 

3. Push the Display/Eject button. The status of the Ethernet connection appears: EnEt=uP, followed by the IP address, for 

example: Addr=172.20.110.11. 

 
NOTE: It might take a few minutes to obtain the address from the DHCP server. Until then, the system displays: EnEt=dn. If 
this address appears, periodically recheck the address until a different address appears. 
 
 
Creating a File System 
During the initial installation of the MDA-T5 system or when installing a new disk pack for the first time to an existing MDA-T5, it 

might be necessary to create a file system on the disk pack. 

 
Windows 2003 or XP Operating Systems 
Microsoft Windows 2003 or XP host systems allow for two disk types, basic and dynamic. A basic disk comes online automatically; 

whereas a dynamic disk must be manually forced on-line each time a pack is removed and reinserted. The basic disk for use on the 

MDA-T5 is recommended. After creating a basic disk, create either an NTFS or FAT-32 file system.  Refer to Microsoft 

documentation for creating a basic disk with an NTFS or FAT-32 file system. 

 
Unix Operating Systems 
On UNIX systems, create standard file systems as you would on any storage device. 

• UFS for oracle Solaris® systems 

• EXT-3 for Linux 

Refer to oracle documentation for information about creating file systems 
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3.h. Starting the Disk Pack Heaters 
 
The heat-phase data string appears when the disk pack temperature and user settings indicate that drives require heating before 

they spin up. This heating information is repeated during the course of the heat phase, which can last up to one hour. The heat 

phase default is 20 minutes. This information is not shown if a heat-phase is not required, or if the heater option is not installed. 

The symbols for the heat phase display are: 

 

 
 

Heat Phase Formula Legend 
 

Display  Indicates  

[  
 
Beginning of data string.  
 

H  
 
Heating symbol.  
 

w=  

 
Current heating level is in use. The “w” value is between 1 - 8. MDA-T5 automatically 
adjusts the heating level in response to time and temperature conditions. 
 

x  

 
Remaining heating time in minutes. This is the maximum time remaining that the disk 
pack will continue to heat, unless the target temperature is achieved first. 
 

t#=  

 
Current temperature symbol. Identifier number (2 or 3) of the sensor reporting this 
temperature.  The reading is from the warmer of the two disk pack sensors. 
 

-yy0c  

 
Current temperature is in Celsius. The minus sign (-) is shown only when negative 
temperatures are reported. 
 

tt=  

 
Target temperature symbol. The heating phase ends when either the current 
temperature is equal to or exceeds the target temperature, or the remaining heating time 
expires. 
 

-yy0c  

 
Target temperature is in Celsius. The minus sign (-) is shown only when negative 
temperatures are reported. 
 

 
]  

 
End of data string.  
 

 
 
 
Expanding Disk Capacity Online  
Online capacity expansion (OCE) allows: 

• Adding any number of disks to an array at any time 

• Accessing the array data while it is being redistributed. 

To increase the size and organization of an array, transform the array. Use the transform function as part of the system backup and 

recover strategy, by using RAID1, RAID10, RAID1n, and RAID10n array types. 
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Migrating RAID Levels Online 
Online RAID Level Migration (ORLM) allows the system to move from one RAID level to another. While the migration is taking 

place, the data is accessible and protected to the lowest protection of either the source RAID level or the destination RAID level.   

The transform feature can be used to increase the size and organization of an array. It can also be used as part of the system 

backup and recover strategy through the use of the RAID1, RAID10, RAID1n, and RAID10n array types. 

 
Performance Considerations 

With RAID, performance is based on four elements: 

• The number and organization of disks in an array 

• Caching attributes being used for the array 

• The application workload 

• PCI bus speed. 

 

Disks 
RAID increases performance by putting more disks to work and by buffering data for the host.  Many disks can transfer data at 

greater than 50 Megabytes per second.  RAIDCore RC5000 Series RAID controllers can aggregate this bandwidth in an almost 

linear fashion, as more of the same drives are included in an array. 

 

Caching 
The RAIDCore RAID controller software can also be configured to provide read and write-back caching, if desired. 

Write-back caching has a large effect on most workloads, but should be used with caution. 

Workload 
When configuring an array, workload is probably the most important performance variable.  Most applications do many more reads 

than writes, so the best performance will be obtained with array types like RAID0, RAID10, and RAID5. 

 

PCI Bus Speed 
Performance bottlenecks can be caused by the type of PCI bus you are using. The maximum theoretical performance of a PCI 32-

bit 33-MHz bus is 132 Megabytes per second. Performance increases to 512 Megabytes per second with a PCI 64-bit 66-MHz bus. 

The best possible performance with the fewest bottlenecks on PCI-X systems can be obtained by using a PCI-X 64-bit 133-MHz 

bus. It offers 1024 Megabytes per second.  For PCIe systems, RAIDCore adapters support a 4x link that offers 1024 Megabytes per 

second in each direction, for a theoretical throughput of 2048 Megabytes per second. 

 
Reliability Considerations 
Reliability is enhanced through data redundancy and backup. 

 
Redundancy 
RAID1, RAID10, RAID5, or RAID50 are necessary for redundancy. With redundancy, both capacity and performance are sacrificed 

for reliability. With RAIDCore RAID controllers, extremely high performance is obtained even with redundant-type arrays. 

 
Backup 
The controller’s ability to transform arrays and split mirrors can be used as part of a backup strategy.  For example, you can create 

a RAID1 or RAID10 array; yet periodically transform them into RAID1n and RAID10n arrays. The RAID1n and RAID10n arrays can 
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be split into the original array and a backup array.  As part of a hot fallback strategy, the backup array can be kept online and hidden 

from the operating system or remain visible, or it can be removed and stored as a backup device.  When a boot array is split, the 

original and the copy are exact copies with the same labels. When using the Linux operating system, One Stop Systems. 

recommends that you keep the split copy hidden during boot time, to avoid boot-time issues with duplicate labels. 

 
Flexibility and Expansion Considerations 
Before configuring an array, consider the following points to enhance the flexibility of your RAID system. 

 
Multiple Types 

Most RAID controllers do not allow 

• Changing a chosen array type 

• Creating more than one type of array for each controller 

• Creating more than one array per physical disk. 

With the RAIDCore RAID controller, different types of arrays can be created on the same disk, to adapt each array to the I/O that it 

processes.  Depending on the array capacity and redundancy level, an existing array can be transformed to another RAID type, if 

the type of array being used is not the optimal type for the application.  Also, different arrays with different characteristics can be 

built for different applications. 

 

Operating System Considerations 
An important array planning consideration is whether to extend the RAID benefits to the system disk and operating system, as well 

as to the data disks.  For example, if the operating system is installed on a RAID1 array (mirror), split the array into two volumes. 

Hide one of the resulting volumes. The operating system can be recovered easily if the system disk fails.  Alternatively, improve 

operating system performance by installing the operating system on a RAID10 array. Split the array and hide one of the RAID0 

arrays (like a hot spare). 

 

3.i. Setting up array through serial port 

1. The serial port is accessed through a RJ-11 connector that is located behind the connector panel on the back of the MDA-T5 

2. The serial port on the client machine should be configured as: 115.200 8, N, 1. 

3. Connector cover plate must be off of MDA T5. 

4. Connect serial port.  

DB9 connector to back of PC RJ11 connector to back of MDA T5 SBB 

5. Power on MDA-T5.  Bootup will take several minutes. The display will stop for about 3 minutes at the line: Bcraid: 

bc_event_kthread thread started if the line above is not displayed within 2 minutes, reset the SBB. 

6. At login: root  

Password: t5 

7. Use bcadm to configure and monitor arrays  
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3.j. Installing a Drive Pack 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Align the mounting slides on the drive pack with the rails on each side of the disk rack compartment. Make sure the drive 

pack handle is in an upright position.  

2. Carefully slide the drive pack straight back into its compartment.  
3. When the drive pack slides into the enclosure and the front of the drive pack is approximately even with the front of the 

enclosure, lower the drive pack handle.  

4. Tighten the thumbscrew. 

5. Wait for the pack to perform a self-test and initialization. 

6. When the individual drives are spun-up, the unit brings the RAID controllers online. Observe the Drive Pack 1 (or 2) Activity 

LEDs on the front of the MDA-T5. When the LEDs are illuminated the indicated drives are ready for operations. 

 

Thumbscrew  

Drive pack handle  



OSS-MDA-T5 
16 

One Stop Systems 

3.k. Removing a Drive Pack  
 
Stopping I/O Transactions 
To remove a disk pack, you must first stop all I/O transactions between the host computer and the drive packs, in order to maintain 

data integrity between the remote host and the RAID Controller(s). 

 
Unmount UNIX File Systems 
If the disk pack has a mounted file system, unmount the file system to ensure that the data structures are properly closed down 

before removing the disk pack. 

To unmount the UNIX file system: 

1. Stop all I/O from going to the logical units that exist on the MDA-T5. 

2. Verify that the file system is un-mounted. 

• List the file system with the df command. 

• Use flags after the command (such as -k) to format the output and make it easier to read and interpret. 

NOTE: Only a superuser can unmount file systems and flush Windows data. 
 
 
Remove a Drive Pack 
 

1. Power down 

2. Loosen the appropriate drive pack thumbscrew. 

3. Grasp the front handle at the drive pack. 

4. Lift the handle fully upright. 

 

 

 

 

 

 

 

 

 

 

 

 

5. Carefully slide the drive pack out of its compartment. 

6. Place the disk pack on a flat, stable surface or in an approved MDA-T5 drive pack transit case. NOTE: Drive pack will sit 

upside down in the transit case. Be sure to hold the unit only by the front handle and the metal tab on the back of the drive 

pack.  

 
  

Thumbscrew  Drive pack handle  
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3.l. Removing/Replacing an SBB 2.0 RAID Controller 
 

1. Turn off the unit using the power switch on the rear of the system. 
2. Remove all of the Fibre cables from both controllers. 

 
 
 
 
 
 
 
 
 
 
 

3. Remove all Fibre Channel Small Form Factor Pluggable (SFP) modules from both controllers by moving the wire release 
lever on each module downward then grasping the lever and gently pulling straight out. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 

4. Unscrew the six rear controller panel screws and remove the rear panel. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Grasp the metal tab on the front top corner of the controller module to be removed and FIRMLY pull straight out. A tool 
may be required to disengage the connectors. Place tool at bottom of bracket as seen in pictures and pull. 

 

Screws Screws 
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Screws 

3.m. Removing Power Supply units 
 
Overview 
The procedure for removing and replacing an individual power supply in the MDA-T5 chassis involves removing the power supply 
rack from the main chassis.  
 

1. Loosen the four screws around the fan bay and gently remove the cover and set to the side being sure not to stress the fan 
wires. 

2. Using thumb tabs, pull the power supply rack from the main chassis. 
 
 

 

 
 
 
 
 
 
 
 
 
 
 

3. Unplug fans (Note the connector release tab) 
4. Gently slide the power supply rack from the main chassis 
5. Stand power supply rack vertically and remove the power supply from the rack. 
6. Remove four screws to release power supply. 
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7. Remove power supply by lifting upward. 

 
 
 
 
 
 
 
 
 
 
 
3.n. Replacing an individual disk drive 
 
Overview 
The procedure for removing and replacing an individual disk drive in the MDA-T5 chassis involves removing the drive box drawer 
from the main chassis. Once the drawer is removed the process to replace a disk drive takes approximately 20-40 minutes, 
depending mostly on the seal cleaning required. This time does not include the set time to re-check for any leaks or the time 
required to determine cause of leaks and repair time. 
 
Materials 
This is a description of equipment required to replace a drive and re-pressurize the drive box. 
 

• Torque screwdriver with Phillips #1 and #2 bits 
• Isopropyl Alcohol 
• A tank of dry inert nitrogen compressed. 
• Nitrogen purging regulator with a low pressure gauge of 5-60 psi, that will thread into the tank. 
• A One Stop Systems drive bay refill parts kit (P/N: OSS-MDA-T5-PARTS-KIT) which includes: 

 An air filler tube, which screws into the flush mount valve stem fill valve that is on the drive box. The air 
filler tube is reusable (P/N: xxx-xxxxx-xxx) 

 One drive pack replacement sealing gaskets (P/N: xxx-xxxxx-xxx) 
• An approximately 10 foot industrial air hose rated 250-300 psi, ¼ inside diameter. 
• Nozzle fittings on the hose, quick-disconnect nose couplings one end male the other female. 
• A standard air chuck that will attach to the hose. So one end of the hose is attached to the regulator gauges and 
the other end has the air chuck that will fit onto the air filler tube. 
• A separate hand held air pressure gauge to check the pressure in the drive box after a set time period to see if it 
has any leaks.  

 Note that the gauges could vary some in what they read, however the goal is to hold nitrogen pressure in 
the drive box, exact psi is not as critical. 
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Procedure  
1. Purge nitrogen from drive enclosure by depressing the bleeder valve on the lower front, behind the air intake, until all 

nitrogen has escaped. 
 

2. Remove a total of (9) screws holding drive signal connector bracket to the mounting plates with isolators, and the flex 
connector. Note: the flex connector may need to be hand squeezed slightly to remove the protective frame. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Remove (8) screws holding drive box assembly to mounting plate isolators. Note that 1 screw also holds the ground wire. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4. Remove (9) screws and washer assemblies holding top of drive box to bottom of drive box. (Note: do not mix the screws. The 
screws at the fill valve end are longer than the screws at the bleeder valve end. .  Unplug heater connector if installed. 
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4. Inspect O-Ring (OSS p/n xxxxx) for cracks, splits, frays, etc. and replace if necessary. Usually replacement is suggested. If 
sealant is detected, it must be removed and the aluminum housing cleaned with Isopropyl alcohol. Be careful not to stretch 
o-ring gasket during installation. 
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5. Remove MUX cardholder bracket. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

6. Pull MUX card back to release drive connections. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
8. Remove selected disk drive. 
 
9. Remove alignment screws from old disk drive and install in new disk drive. 
 
 
10. Insert new drive into drive box being sure that alignment screws are placed in 
alignment cores in bottom of drive enclosure. 
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11. Once new drive is properly installed, replace MUX card so that all disk drives are plugged into appropriate slots in card. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
12. Replace MUX cardholder bracket 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
13. When MUX card and bracket is properly installed, replace drive enclosure top being 
sure that rubber o-ring is inspected and clean, mating surfaces are clean, and o-ring is 
secured properly in groove. Plug in heater connector. 
 
 
 
 
14. Replace screws and washer assemblies holding drive enclosure halves together. 
Torque screws to 15 in-lbs. in a staggering pattern to maintain equal pressure throughout 
the drive enclosure. 
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15. Apply dry nitrogen to drive box by removing the cover on the fill valve, upper rear of drive box, and installing the filler tube. Hold 
the bleeder valve in, on the lower front of the box behind the air intake, while simultaneously filling with nitrogen using the air chuck 
from the tank for approximately 1 minute or until all oxygen has been purged from inside of drive enclosure assembly. Release the 
bleeder valve and fill box with approximately 5-10 psi of dry nitrogen. Let drive box set for approximately 24 hr and check pressure 
with an air pressure gauge to determine if there are leaks. 
 
 
16. Re-assemble (8) screws and washers holding drive enclosure to mounting plate isolators. Note that 1 screw holds the ground 
wire. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
17. Re-assemble drive signal connector bracket. Note: hand squeezes the flex connector so that the frame slides over it easily. Be 
careful not to pinch wires. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
18. With handle in horizontal position, replace drawer into 
main chassis being sure that all connectors align 
correctly. Push handle down to lock drawer into correct 
position. (Note: do not use undue pressure to force 
handle into locked position. If handle does not go into 
locked position remove drawer and check connector 
alignment). The handle does not go into locked position 
remove drawer and check connector alignment). 
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4. Using the BIOS Configuration Utility 
 
4.a. When to Use the BIOS Configuration Utility 
 
The firmware component of the installation kit includes the BIOS Configuration Utility. Use this utility to: 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
NOTE: The first device in the Arrays list is the bootable array. The system can only boot from the first device in the list. 
 
NOTE: Until the BIOS loads, the LEDs are not indicative of disk connectivity. 
 
To enter the BIOS Configuration Utility 
When booting the system, press CTRL + R when the BIOS banner displays. You have a minimum of three (3) seconds to enter the 
BIOS, using this key combination. 
 
 
4.b. Understanding the Color Code in the BIOS 
 
The following color codes are used to indicate the type or status of information displayed on the screen. 
 

Color Description 
White text Available option or information text. 
Yellow highlighting Current option on which you may choose to take action. 
Green text Item has been selected. 
Light blue text Item is not available for selection 
Yellow text Informational text, describes an option 
Magenta text Spare options and boot options. 
Red text Failed drive or other warning to user. For example, informational text might be red if the option 

is not available. 
 
 

Action Description Find More Information At...  
Create the boot array 
 

If the system is not booting off of the array, 
this utility does not need to be used to create 
an array, although it can. A non-bootable 
array can be created in the RAIDConsole 
management application 

See “Creating Arrays Larger Than 2TB” in 
Chapter 8, Using the RAID Console. 
or 
See “Creating New Arrays: bcadm --
create” in Appendix E, Using bcadm. 

Swap in a copy of the 
boot 
array 
 

In RAIDConsole, a copy of your boot array 
can be made by mirroring the array and then 
splitting it; by default, it is hidden from the 
operating system. If the system were to lose 
the boot array, the BIOS Configuration utility 
can be used to unhide the copy and swap it 
into the first position in the Arrays list. 

 

Initialize a new disk 
 

When a new disk is being added, it can be 
initialized from the BIOS. 
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4.c. Initializing Disks from the BIOS 
Before new disks are used, they must be initialized. At the very least the boot array must be created using RAIDCore BIOS Array 

Configuration utility. Initialization writes the RAIDCore configuration information to disk. This process is the same whether there is 

one controller or multiple controllers. The BIOS utility can be used to create and manage arrays, so that an operating system can be 

installed on an array. The system is booted from this array. 

 
To initialize disks from the BIOS 
1. Power-up the computer to start booting. 

2. When prompted, press the CTRL + R keys, to access the RAIDCore BIOS Array Configuration utility. 

The RAIDCore Array Configuration menu is displayed (see “Understanding the Color Code in the BIOS” on page 6-3). 

NOTE: If the BIOS is not displayed, contact OSS support. 
3. Use the arrow keys to select INITIALIZE DISK(S) from the Main menu. 

4. Press ENTER. 

5. Use the arrow keys to highlight a disk, and then press the Insert key to select the disk or choose all selectable disks by pressing 

the A key. 

NOTE: Multiple disks can be selected; there is no need to initialize one disk at a time. 
6i. Press ENTER to initial ze the selected disks. 

7. Press the C key to continue with initialization. 

Initialization takes 10–15 seconds per disk. A status indicator shows which disk is being initialized. When the initialization is 

complete, the status indicator goes away. A complete rescan of all channels is done automatically. 

CAUTION: If a disk has a RAIDCore array on it, the disk cannot be selected. To initialize this disk anyway, delete the array. 
Be sure this is what you want to do, because the data on the disk will be deleted. 
 

4.d. Creating Arrays from the BIOS 
After your disks are initialized, you can create arrays. See “Understanding Arrays” in Appendix B, Overview of RAID Concepts, if 

you have not yet decided what type of arrays you need. 

Before You Begin... 
• In some circumstances, more than eight arrays are possible. They might appear to function properly, but are not supported by 

OSS. 

• For redundant arrays, the creation process is not finished until after the operating system and controller drivers have been installed 

and the system has been booted into the operating system context. However, the arrays are immediately available to use for either 

a boot or data array. 

• Array numbers are valid only for a given boot, and might be different in the BIOS and drivers. If a permanent label is required, use 

the labeling feature. 

• When a disk is highlighted from the disk list, the LEDs on the controller or a properly cabled disk enclosure light up to identify that 

disk. 

• At any point in this procedure, return to a prior window by pressing ESC. 
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To create an array 
1. From the Main menu of the Array Configuration screen, use the arrow keys to select “Create Array”. Press ENTER. 

2. Select the disks on which to create the array: 

a. Highlight the disk by using the arrow keys. 

b. For each disk, press INSERT to select the disk. You can insert the disks in the order of your choice. 

c. After selecting the disks to be included in the array, press ENTER. 

3. In the “User Input” area, use the arrow keys to select an array type. Press ENTER. (Only array types that can be created with the 

selected disks are available). 

4. If spares are applicable: 

a. In the “User Input” area, use the arrow keys to highlight a spare type. 

b. If applicable, in the “Disks” area, highlight the disk(s) to use as a spare. Press INSERT to select them. 

c. Press ENTER to add the spare disk(s). 

 

To select an array size 
NOTE: Use the Page Up and Page Down keys to increase or decrease the array size in large increments. Use the up arrow 
and down arrow keys to increase or decrease the array size in small increments. 
1. Use the Page Up/Page Down keys or the arrow keys to select a size. Press ENTER. (By default all available space up to 2.199 

TB is selected). 

or 

2. Create an array that is greater than 2.199 TB (the maximum allowed by some operating systems): 

NOTE: 32-bit operating system do not support arrays larger than 2TB. See “Creating and Formatting Arrays” in Chapter 5, 
Using the RAIDConsole. 
• Press PAGE UP or the up arrow to increase the array size. You are asked if you want to limit the size of the array to the 2TB 

maximum. 

• Press ESC to create a larger array. 

• Press PAGE UP or the up arrow until you have reached either the desired size or the maximum available. 

• Press ENTER. 

3. Select a caching level using the arrow keys. Press ENTER. 

4. Press C to confirm that you want to create the array. 
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NOTE: The array is marked “Ready” for use. The text at the top of the Array Configuration screen returns to a description 
of the menu items. 
5. When you are finished creating arrays, resume the boot process: 

a. From the Main menu, highlight “Continue to Boot”. 

b. Press ENTER. No reboot is required. 

6. See Figure 6-1 for an example of a configured 4-drive RAID5 array. 

 

 

 
 
 
 
 
 
 
 
 
 
 
4.e. Deleting Arrays from the BIOS 

CAUTION: Deleting an array permanently destroys all data that was on the array. This action cannot be undone; all data 
will be lost. 

To Delete an Array 
1. Highlight “Delete Array(s)” from the Main menu. Press ENTER. 

2. Do one of the following: 

• Highlight each array to delete. Press INSERT to select it. 

or 
• Type A to select all arrays for deletion. 

3. Press ENTER. 

4. Press C to continue. 
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4.f. Swapping Arrays from the BIOS 
Using the “Swap Two Arrays” option, arrays can be arranged in a different order. 

Before you begin... 
• If more than one array is created, install the operating system to any of them. However, a small amount of boot information is 

always written to a disk in the first array on the array list, regardless on which array the operating system is installed. If anything 

happens to the disk in Array 1, the system cannot be booted. OSS recommends installing on a redundant array-type—such as 

RAID1 or RAID5—and swapping that array into the first position, if it is not already Array 1. 

• This swap feature is only available from the BIOS. 

To swap arrays 
1. Highlight “Swap Two Arrays” in the Main menu. Press ENTER. 

2. Use the arrow keys to highlight an array. Press INSERT to select an array. 

3. Use the arrow keys to highlight another array. Press INSERT to select the array. 

4. Press ENTER to swap the arrays. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In this example, the RAID10 array was the first array created. However, to boot from the RAID5 array, the arrays were swapped so 

that the RAID5 array is the first device listed. 
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4.g. Hiding or Un-hiding Arrays from the BIOS 
The “Hide/Unhide” array option allows you to hide or unhide an array or arrays from the operating system. If an array is hidden it will 

not be visible through INT13 or to the operating system when booted. This is a useful feature for hiding hot backups of the system. 

NOTE: A legacy array cannot be hidden from the BIOS. A legacy array can be hidden from the operating system (using 
RAIDConsole or bcadm), as long as the system is not booted off the legacy array and another non-legacy disk is attached 
to the controller. 

To hide or unhide an array 
1. Select the “Hide/Unhide” option. 

2. Use the arrow keys to highlight the array to be hidden or un-hidden. 

3. Press INSERT to select an array. 

4. Press ENTER to commit the selection. The hidden array turns blue in the “BIOS Configuration Utility”. The status of the array 

displays as “Hidden”. 

 

4.h. Viewing Disk Details from the BIOS 
This option allows you to view details about the disk.  Nothing can be changed from this menu option. It is for informational 

purposes only. 

To view disk details 
1. From the Main menu, select “View Disk Details”. 

2. Use the arrow keys to choose a disk. 

3. Information about the disk is displayed in the “Information” field across the top: 

• Disk Number 

• Controller Number 

• Channel Number 

• Disk Size 

• New/Legacy/Empty/InArray 

• Free space 

• Disk Model Number 
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4.i. Viewing Array Details from the BIOS 
This option allows the details of the array to be viewed. Nothing can be changed from this menu option. It is for informational 

purposes only. 

To view array details 
1. From the Main menu, select “View Array Details”. 

2. Use the arrow keys to choose an array. 

3. The full details of the array are displayed in both the Information field across the top: 

• Array Number 

• Type 

• Size 

• State 

• Name 

• Cache Setting 

• DOS Size 

NOTE: The disks list shows the disks in the array, as selected (green). 
 

4.j. Rescanning All Channels from the BIOS 
This option allows you to rescan all channels to detect new or removed disks and arrays. 

1. To perform a rescan, select “Rescan All Channels” from the Main menu. (The activity indicator in the “Information” field spins 

while the disks are being polled). 

2. The “Rescan All Channels” option rescans all the channels, searching for new or removed disks, and rereads the configuration 

information from each disk. 

NOTE: Sometimes when a disk is offline, it can be brought online through a rescan. Rescan also stops, and then 
automatically resumes, all tasks 
 

4.k. Changing Controller Options from the BIOS 
Selecting Controller Options allows you to configure whether RAIDCore arrays might be bootable, as well as other aspects of the 

boot process. The default is to configure an array. An operating system can boot from the RAIDCore RC5000/BC4000 Series RAID 

controller. If an error occurs, an error message is displayed. However, you might be booting from the motherboard IDE or another 

SCSI device in your system. If this is the case, do not install INT13 (without INT13, DOS cannot see the array). 

NOTE: If “Boot Mode” is configured to install INT13 and never display an error message, you will not know during the boot 
process if an array is degraded or if other problems have occurred. 
One symptom of having too much memory used by the option ROMs is a blank screen, with the message “Couldn't initialize 

memory” appearing in the top left hand corner. No additional information is given. This message is coming from the NT Boot 

Loader, which requires 512 KB of memory free below 640 K. This menu also sets whether the boot process will pause when an 

error occurs. When the “Pause” feature is enabled and an array goes critical or offline, or there is a controller configuration error, the 

boot process stops. Press ENTER to continue booting. View the error message on the window. If the “Pause” feature is disabled, 

the error message is displayed briefly, but the system continues to boot. 
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To select a boot option 
1. From the Main menu, select “Controller Options”. 

NOTE: The “Controller Options” area is displayed in the BIOS Array Configuration utility window, as shown in Figure 6-3, 
in the Controller Options area of the BIOS Array Configuration screen. The current settings display in magenta text above 
the white selectable options. 

 

 
 
 

 
 
 

 

 

 
 
 
 
 
 
 
 
2. Use the arrow keys to select a boot option. 
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NOTE: By default, all options are turned on. OSS recommends that options remain enabled. 

 
4.l. Linux Kernel Issues and Recommendations 
Issues 
When the libata driver is loaded by these newer Linux kernels (beginning with some errata kernels for Fedora Core 2, and all 

kernels for Fedora Core 3) the RAIDCore RAID controller is recognized as a simple SATA controller and is taken over by the 

operating system. If this problem occurs on your system, any previously created arrays do not appear as arrays, but only as a group 

of individual disks. 

Recommendations 
By turning off the “legacy” ID used by all RAIDCore RAID controllers, the newer Linux kernels can recognize the MDA-T5 as a RAID 

controller. A RAIDCore driver that is version 1.4 or later must be used (drivers that are version 1.3 or earlier will not be able to 

recognize the RAIDCore controller). All Linux systems will work properly with the legacy board ID disabled. It can be enabled and 

disabled as needed. If any problems are encountered after disabling the legacy ID, re enable it to get back to a working system. 

 

Limiting Disks Numbers and Reducing Power Demands 
To limit the number of disks that can spin up at the same time and reduce power demands by the system, perform the following: 

1. Highlight “Set Staggered Spinup Count”. 

2. Press ENTER. 

3. Using the arrow keys, specify the number of disks that should be allowed to simultaneously spin up. 

4. Press ENTER again. 

 

Continue Booting from the BIOS 
After you have created arrays, you can continue booting the system from the point where the RAIDCore BIOS was entered. To 

resume the boot, highlight “Continue to Boot” in the Main menu. Press ENTER. No reboot is required. 

 

 

To Accomplish This... Do This... Notes 
Not boot from an array 1. Highlight “Toggle INT13 Installation,” 

using the arrow keys. 
2. Press ENTER to change the setting to 
“Disabled” 

OSS recommends disabling INT13 only if 
you want to boot from another device and 
Leaving the rest of the options enabled.) 

Turn off critical arrays while booting 1. Highlight “Toggle Pause if Critical”. 
2. Press ENTER to change the setting to 
“Disabled”. 

 
Turn off warnings due to offline arrays 
when booting 

1. Highlight “Toggle Pause if Offline”. 
2. Press ENTER to change the setting to 
“Disabled”. 

 
Turn off warnings due to controller 
configuration errors when booting 

1. Highlight “Toggle Pause if Error”. 
2. Press ENTER to change the setting to 
“Disabled”. 

These warnings include errors generated 
when the license key is not found or is 
Corrupted, or when the license level does 
not match on all controllers in the system 
and the lowest level found is used. 

Allow the RAIDCore RAID controller to 
work with newer Linux kernels that load 
the libata driver. 

1. Highlight “Toggle Legacy Board ID”. 
2. Press ENTER to change the setting to 
“Disabled”. 
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5. Using the RAIDConsole 
 
5.a. To start RAIDConsole under Linux 
1. Open a command prompt and type /usr/bin/bc_winraid. 

NOTE: For most Linux systems, this starts RAIDConsole and also starts the bc_service application that logs events in the 
system. It also starts the bcapiservice application that enables remote management. 
2. If these applications do not auto start, start them manually. Auto start them next time. 

3. Alternatively, stop them and keep them from autostarting next time by changing to the /etc/init.d/ directory from a console window. 

Type the following: 

• For bc_service: bcserviced start | stop 

• For bcapiservice: bcapid start | stop 

4. If you want a pop-up message to appear on the desktop when an event is detected by bc_service and reported to the log, run the 

bcpopup application. Open a command prompt and type /usr/bin/bcpopup. 

5. Open the Security Level Configuration window by clicking Desktop from the menu bar. 

6. Click SYSTEM SETTINGS. 

7. Click SECURITY LEVEL. 

8. At the Security Level Configuration screen, select the “SELinux” tab. 

9. Disable SELinux by un-clicking the first option. Or, change the policy from “Enforcing” to “Permissive” by clicking the second 

option. See Figure 7-1. 

10. When RAIDConsole starts, the First Time Run window opens and inquires whether password protection for the application is 

needed. See “Using Password Protection” on page 7-4 for information and instructions. 
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5.b. Using Password Protection 
 
OSS strongly recommends that the RAIDConsole management application be protected by a password. Misuse of the application 

could easily result in destroyed data. Password protection for the application can be enabled or disabled the first time it is started, 

using the First Time Run dialog, as shown in Figure 7-2. If you choose not to protect the application with a password at this time, 

you can do it later from the Options menu. 

 

 
 
 
 
 
 
 
 
 
 
 
Things to Know About Passwords 
• If you forget your password you will not be able to run the application. Select a password that you will remember. 

• The password must be at least six characters long. 

• The password is case sensitive. 

• Four chances are given to enter the password correctly. If you fail to type the password correctly, the application will close after the 

fourth try. To try again, reopen the application. 

• The application does not keep track of passwords that have been previously used. 

To set Password Protection from First Time Run 
1. Type a password in the “Password” box. 

2. Confirm the password by typing it again in the CONFIRM box. 

3. Click CONTINUE. The Array Status window opens. 
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To disable Password Protection from First Time Run 
1. Select “Disable Password Protection”. 

2. Click CONTINUE.The Array Status window displays. 

 

To set Password Protection later from the Options menu 
1. On the Options menu, select PASSWORD. 

2. Check “Enable Password Protection”. 

3. Enter a password. 

4. Confirm the password by typing it again. 

5. Click OK. 

 

5.c. Using the Help Menu 
The Help menu on the Array Status screen provides access to the following: 

• Click on the “Help” tab and then do one of the following: 

• Click CONTENTS & INDEX to view the web-based online help system 

• Click ABOUT to view the version information. The following information is provided (see Figure 7-3): 

• Version information is provided for the RAIDCore miniport driver (bcraid.sys) 

• The configuration driver (bccfg.sys) 

• The array maintenance service (bc_service) 

• The remote management service (bcapiservice) 

• RAIDConsole (bc_winraid) 

• The pop-up message utility (bcpopup) 

• The dynamic link library (bc_vbdll.dll). 
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To copy the version or license information, click COPY TO CLIPBOARD. Paste the information into a text editor, such as Notepad. 

This method captures the serial numbers of the disk drives in the system, which are listed by the designation Disk x: y, where x is 

the controller number and y is the port number. 

 
5.d. Reviewing the Interface 
The Array Status Window 
The Array Status window is the main window within RAIDConsole. From here you can view configuration information such as 

physical disk status, logical array status, and task information. It also provides the main function menus for managing arrays. As 

shown in Figure 7-4, the Array Status window includes: 

• An “Array View” area 

• A “Disk List” area 

• An “Array List” area 

• An “I/O Status” bar. 
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NOTE: Certain languages do not display correctly in the “Array View” area. The source of this problem is not within 
RAIDConsole itself. English, other English variants, and many other languages do display properly. If desired, use the 
Control Panel to set the regional language to English or another language. NOTE: To refresh the array and disk 
information displayed in the Array Status window, click View, and then click Refresh. This command rereads configuration 
information from the driver, but does not poll the disks. 

 

5.e. Array View Elements 
Array View Area of the Screen 
The “Array View” area on the left side of the Array Status window presents a graphical view of array properties during and after the 

creation of the array. 

Elements at the Array View Section of the Array Status Screen. 

Array The array number assigned to created or creating arrays. 
Array name The name assigned to an array. 
Task Percent Complete 
and ETA 

The progress of a current array task, such as a create or 
transform, shown as percent complete and estimated time left to 
completion (hours: minutes: seconds). 

Task type The nature of a current task, such as a create or transform. 
Source array The original array to be transformed. 
Destination array The array to which the source array is being transformed. 
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5.f. Array View Icons 
 
The icons in the “Array View” area reflect the type of array (RAID0, RAID1, etc.) and which controller it appears on. An example 
configuration of icons is shown in Figure 7-5. 
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5.g. Disk List Elements 
The “Disk List” area on the Array Status screen provides information about all disks assigned or available to arrays. See Table 7-2. 

 

 
NOTE: If there are any disk drives missing from the Disk List, the most likely cause is a loose cable. Ensure that all disk 
cables are connected and then rescan the disks. 
 
 
5.h. Array List Elements 
The “Array List” area of the Array Status screen provides information about the arrays. 

 
Array List Area of the Array Status Screen. 

Device The array number 
O.S. Name Name assigned by the operating system to the array. The name appears as “Hidden” if the array 

is hidden from the operating system. The name appear as “??” if the array is OFFLINE. 
Partition| 
Mount Point 

Drive letter or letters than have been assigned to this array. 
NOTE: If a dynamic volume is created on an array, RAIDConsole cannot retrieve the 
volume’s drive letter. 

Array Name User-supplied name for the array 
Type RAID type 
Total Capacity Total capacity: 1MB = 1,000,000 bytes, 1GB = 1,000,000,000 

bytes 
State State of the array (NORMAL, CRITICAL, OFFLINE) 
Task Task type if in progress (TRANSFORM, COPY, CHECK, CHECK_BITMAP, NOT_ACTIVE, 

CREATE, RESTORE) 
Task State The state of the task (STARTED, PAUSED, COMPLETED); the progress of the task is given in 

the “Array View” area. 
Priority Task priority if a task is in progress. 
Scan Background Array Scan enabled? (Yes/No) 
Cache Current cache setting (NC=No Cache, R=Read Cache, W=Write- Back Cache, RW=Read/Write 

Cache) 
Dst Spare Indicates whether the distributed spare option is being used. 
Dsd Spare Indicates the number of dedicated spares assigned to the array. 
 

 
 
 
 
 
 

Ctrl Chan Disk controller and channel number 
State State of the disk (ONLINE, FAILED, UNKNOWN) 
Type Disk type (DISK, Legacy, NEW) 
Port Type Type of port (SATA, SATA II, SAS) and its port speed; this is the speed the controller 

negotiates, not the speed of the port type. 
Capacity Disk capacity: 

1 MB = 1,000,000 bytes 
1 GB = 1,000,000,000 bytes 
NOTE: Because the ATA storage industry has standardized the meanings of MB as 
1,000,000 bytes and GB as 1,000,000,000 bytes, the RAIDCore software reports the same 
units. 

Free Space Total amount of space unused on the disk 
Largest Free Largest contiguous unused space on the disk 
GS Indicates if disk is assigned as a global spare 
Model Number Disk manufacturer’s model number 
Firmware Revision Disk manufacturer’s firmware version 
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5.i. I/O Status Bar Elements 
The “I/O Status” bar in the Array Status screen provides the following information: 

I/O Status Bar Elements, Array Status Screen. 

Host x.x MB/s Host traffic in megabytes per sec. 
Disk x.x MB/s Disk traffic in megabytes per sec. 
Host x I/O’s Host I/Os per second. 
Disk x I/O’s Disk I/Os per second. 
Host Queue Number of Host I/O requests currently in progress. 
Disk Queue Number of Disk I/O requests currently in progress. 
Dirty Number of dirty cache buffers if write caching has been enabled 

(or, the number of buffers not actually written out to the drives). 
This is informational only and not an error condition. 

Host Total amount of data transferred to or from the host since last 
boot. 

Disk Total amount of data transferred to or from the disks since last 
boot. 

 
NOTE: The I/O status indicators are approximate in nature, especially when the system is experiencing a high volume of 
I/O traffic. 
 
 
5.j. Working with Disks 
Initializing Disks 
When disks are initialized, the RAIDCore configuration information is written to the disks. If the disks are new and have not been 

used before, they must be initialized before they can be used in RAIDCore arrays. After a disk is initialized, it shows as a “Disk” type 

in the Disk List. 

CAUTION: Normally, do not attempt to initialize disks that are part of an array. However, it is possible to do so, unless the 
disk is part of the boot array. (If the disk is part of multiple arrays, it cannot be initialized). 
 
To initialize disks 
1. On the “Disk” menu, select INITIALIZE. “Initialize Disk” is displayed. 

2. Select the disk(s) to be initialized, by clicking on the box next to the disk(s). 

3. Click INITIALIZE SELECTED. 

 
5.k. Rescanning Disks 
The “Rescan Disks” option: 

• Rescans the serial ATA (SATA) channels that search for new or removed disks 

• Rereads the configuration information from each disk. Sometimes when a disk is offline, it can be brought online through a rescan. 

Rescan also stops and then automatically resumes all tasks. To rescan disks, select “Rescan” at the on Disk menu. 

 
CAUTION: Normally, do not attempt to initialize disks that are part of an array. However, it is possible to do so, unless the 
disk is part of the boot array. (If the disk is part of multiple arrays, it cannot be initialized). 
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5.l. Changing Cache Settings for Disks 
If the disks support this option, “read ahead” and “write cache” properties can be changed. The default settings are to have “read 

ahead” and “write back caching” enabled. 

CAUTION: Leaving “write back caching” enabled might increase the likelihood of data being corrupted, if the system 
experiences a power interruption or unexpected shutdown. 
 
NOTE: The disk cache settings cannot be changed if any tasks are active on the arrays. The option is enabled when the 
tasks are complete. 

 
To change disk caching properties 
1. From the Disk menu, select “Properties”. 

 

 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
2. Select the disks. See Figure 7-6. 

3. Under “Disk Properties,” click the ENABLE or DISABLE FOR THE DISK WRITE BACK CACHING and DISK READ AHEAD 
settings. 
4. Click EXIT. 
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5.m. Changing Disk View Settings 
At the View menu click either DISK LIST VIEW or PHYSICAL VIEW. The “Disk List View” is a view of the disks in a list format (as 

described in “Disk List Elements”). It is the default view. In this view, you can: 

• Right-click on a disk in the “Ctrl Chan” column to add or remove a dedicated or global spare. 

• View information such as disk capacity and amount of free space, which do not display in the physical view. The “Physical View” is 

a graphical representation of the disks and their status. A default picture is provided, but any JPEG (*.jpg) format image can be 

inserted and edited to match the configuration of your disks. 

 
An example “Physical View: is shown in Figure with the default *.jpg image supplied with the application. 
 
 

 

 
 
 
 
 
 
 
 
If a new controller is added to the system, the physical view must be edited. The disk information in this view is not updated 

automatically. 

 

Operations at Physical View 
The following operations can be performed at the “Physical View”: 

Creating a Dedicated Spare 
Right-click on a disk-identifying box to assign it as a dedicated spare (if available), or to assign it as a global spare. 

Identifying a Disk 
Right-click on a disk-identifying box to use LEDs to identify that disk on a controller or in an enclosure. 

Seeing Disk Status 
See disk status as conveyed by the font and background color of the disk identifying boxes. 

Editing the Physical View 
Use “Edit Physical View” on the Options menu to: 

• Add your own *.jpg file, 

• To show or hide a disk in the view. 

• To change the positions of the disk identifying boxes, in order to match the configuration of your actual disks in their enclosure(s). 

 



OSS-MDA-T5 
44 

One Stop Systems 

Operations at Physical View 
The following operations can be performed at the “Physical View”: 

Creating a Dedicated Spare 
Right-click on a disk-identifying box to assign it as a dedicated spare (if available), or to assign it as a global spare. 

Identifying a Disk 
Right-click on a disk-identifying box to use LEDs to identify that disk on a controller or in an enclosure. 

Seeing Disk Status 
See disk status as conveyed by the font and background color of the disk identifying boxes. 

Editing the Physical View 
Use “Edit Physical View” on the Options menu to: 

• Add your own *.jpg file, 

• To show or hide a disk in the view. 

• To change the positions of the disk identifying boxes, in order to match the configuration of your actual disks in their enclosure(s). 

 

5.n. Using LEDs to Identify Disks 
The “Identify Disk” option can be used within RAIDConsole to physically identify a disk. By selecting a disk within RAIDConsole and 

using this feature, the LED on the controller or a disk enclosure blinks for that disk. If a disk fails, this feature can be used to 

physically identify which disk in the enclosure has failed. 

NOTE: If the LED cables between a disk enclosure and the controller are not properly connected, the wrong disks might be 
identified. 

To use LEDs to identify a disk 
1. In the “Disk List” area, right-click the disk that you want to identify. 

2. When the Options window is displayed, click IDENTIFY DISK USING LEDS. Click OK. When the Identify window is displayed, 

the LED for that disk begins to blink. 
3. To stop the LEDs from blinking, click STOP IDENTIFY. 
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5.o. Working with Arrays 
Creating and Formatting Arrays 
Unlike many RAID controllers, the RAIDCore RC5000/BC4000 Series RAID controllers allow the partitioning and creation of as 

many as eight arrays across all disks. Portions of disks can be used to create arrays, while other arrays are using different portions 

of the same disks. A maximum of eight arrays can be created. 

Before You Begin... 
Issues and Recommendations for Creating and Formatting Arrays. 

Issues Recommendations 
Access to arrays The creation of arrays, even redundant arrays, allows users 

immediate access to the arrays, unless the zero option is used 
during the create. 

Array numbers Array numbers are valid only for a given boot, and can be 
different in the BIOS and drivers. If a permanent label is 
required, use the labeling feature described in “Naming Arrays” 
on page 7-43. 

Array size The array size of the new array is limited to 2.199 TB on some 
versions of Windows and Linux. Refer to your operating system 
documentation for details on maximum array sizes. 

Number of arrays In some circumstances, more than eight arrays are possible. 
They might appear to function properly, but are not supported by 
OSS. 

System reboot If the system reboots, the creation process continues where it 
left off. 

 
5.p. To create an array 
Select an Array and Cache 
1. From the Array menu, select CREATE. 
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The Create Screen, with the Disk List. 
2. In the “Disk List,” select the disks to include in the array by checking the box next to the desired disks. 

 

NOTE: Click the ALL button to select all disks, or click the UNUSED button to select those disks that have yet to be used 
in an array. 
3. Select an array type from the “Type” list. 

4. Enter the capacity in the “Capacity” field. 

NOTE: The maximum available capacity changes with the disks selected, array type, and the sparing options chosen. 
Select a cache option for the array. The default is Read + Write Back Cache. 

 

Select Options and Configurations 
1. Select whether to configure distributed and/or dedicated spares by clicking the appropriate option. 

NOTE: See “Working with Spares” in Appendix D, General Concepts for Managing Arrays and Disks, to determine what 
type of spare or spares to assign. 
Select whether to enable background array scanning by clicking the Background Array Scan option. 

 

3. Choose whether to skip initialization by clicking the Skip Initialization option. 

NOTE: Arrays can be created instantly by skipping the background consistency check usually performed when initializing 
the array. For certain types of redundant arrays this is a viable option and has no data integrity drawbacks. A consistency 
check can be performed at a later time. For RAID5 and RAID50 sets, if the initialization is skipped, the arrays are not 
redundant until a consistency check is performed. Creating a RAID 5 array with this option selected, and a cache option of 
“No Cache,” can in some situations result in data corruption. 
 
4. If the configuration information for an array is lost and you want to leave data that was on the disks untouched when writing new 

configuration information, check the option to “Leave Existing Data Intact”. 

NOTE: This option can be used to try and recover user data when an array has been accidentally deleted or when the 
configuration information is lost but the data is still intact. When an array is created with this option enabled, new 
configuration information is written while trying to use exactly the same disk space that was used before. Generally this 
option is used as a last resort. The likelihood of recovering data with this method is very low, unless it is performed 
immediately after the array was deleted and no other tasks have been performed on the array. 
5. Choose whether to use the “Zero Create” option, which writes the created array with zeros. If the “Zero Create” option is used, 

the array is not immediately available. 

6. Name the array, if desired. 

NOTE: Names can be up to 30 characters long. However, the BIOS will display only 17 of those characters. 
Click CREATE to create the array. A 4-disk RAID0 array is created in the Create window. 
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To partition an array for use with Windows 
Use the standard operating system format procedure to format an array. If you are unfamiliar with this procedure, use the following 

procedure for Windows 2003: 

1. From the desktop, right click MY COMPUTER. 

2. Select “Manage”. 

FIGURE 7-9. Computer Management Screen, Showing the Disk Management Selection. 
3. Click DISK MANAGEMENT.  

 

 

 
 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Computer Management Screen, Showing the Disk Management Selection. 
3. Click DISK MANAGEMENT. 
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4. Follow the instructions provided by the “Write Signature and Upgrade Disk Wizard” to write a signature on the drive. When you 

close the wizard, the Computer Management window reappears. 

 

 

 
 
 
 
 
 
 
 
 
 
 
Computer Management Screen, Showing the Disk Volume and Partition Information. 
The “O.S. Name” is the same name found in the Array Status window. This is the array that needs to be formatted before it can be 

used. 

To format the array 
1. Right click in the white area surrounding the new partition and select Create Volume. 

2. Follow the instructions provided by the Create Volume Wizard to format the disk. 

NOTE: Expansion is easiest if the array is formatted with NTFS. 
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Creating Arrays Larger Than 2TB 
In the SCSI miniport architecture, there is a limit of approximately 2 Terabytes (TB) per array. Arrays larger than this do not operate 

properly. This means that RAIDConsole does not allow you to create an array larger than this limit. Windows addresses this 

problem in two different ways. 

 

Creating Arrays Larger Than 2 TB. 
 

Operating System Description Notes 
Windows 2003 and 
64-bit Windows XP 

Disks greater than 2 TB are converted to the GUID Partition 
Table (GPT) format. This format supports very large array 
sizes (up to 18 Exabytes) and has no artificial constraints on 
the number of partitions. 

See Chapter 16 of the Extensible 
Firmware Interface (EFI) specification for 
details on GPT disks. 
 

32-bit Windows XP 
and 2003 

Disks greater than 2 TB are created from groups of smaller 
arrays through the use of dynamic volumes. Dynamic 
volumes can be striped together using the Windows Disk 
Management utility to create arrays larger than 2 TB from 
groups of smaller arrays. 

 

 

 

To create volumes larger than 2 TB on Windows 2003 and 64-bit XP 
1. Create an array using the “Create” command. Specify the size of the array. 

2. For the “Type” field, select a desired array type. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
NOTE: To create arrays larger than 2 TB on 32-bit Windows 2003, make sure that Service Pack 1 has been installed in the 
system. 
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3. From the desktop, right-click MY COMPUTER. Click MANAGE. 

4. Under “Computer Management (Local),” click STORAGE/DISK MANAGEMENT. The Initialize and Convert Disk Wizard window 

opens. 

Initialize and Convert Disk Wizard Screen. 
 

 

 
 
 
 
 
 
 
 
Initialize and Convert Disk Wizard Screen. 
 
5. Click NEXT. 

 
 

 
 
 
 
 
 
 
 
 
Initialize and Convert Disk Wizard Screen, Showing the Selected Disk. 
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4. Select Disk 1, or the disk number of the new array. Click NEXT to initialize the array. 

 

 

 

 
 
 
 
 
 
 
 
 
Initialize and Convert Disk Wizard Screen, Showing the Initialize to MBR Disk. 
 
7. Close the Initialize and Convert Disk Wizard by clicking FINISH. 

8. In the Computer Management window, position the cursor over the Disk 1 icon. Right-click and select the “Convert to GPT Disk” 

option. 

NOTE: The two sections of the disk now are merged into one.  
 
 
 

 

 
 
 
 
 
 
 
Computer Management Screen, Showing the “Convert to GPT Disk” Option. 
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Computer Management Screen, Showing the Merged Sections of Disk 1. 

6. Close the Computer Management window. 

 

7. The new array appear in the “Array List” area at its specified size. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

RAID Controller Screen, Showing the Array List. 
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To create volumes larger than 2 TB on 32-bit XP: 
1. Decide how many maximum-sized (2.199 TB) arrays are needed. To do this, take the whole-number result of dividing the desired 

total array size by 2.199 TB. For example: Desired array size = 2.46 TB. Maximum-sized arrays needed = (2.46 / 2.199) = 1 258 GB 

is the remainder. 

2. If any space is left over (e.g., 258 GB in the above example), create one more array the size of the remainder. 

 

 
 
 
 
 
 
 
 
 

RAIDConsole Screen, Showing the Array Limit in the “Array List”. 
 
3. From the desktop, right-click MY COMPUTER. 

4. Click MANAGE. 

5. At the Computer Management screen, click DISK MANAGEMENT. (The Initialize and Convert Disk Wizard window opens). 

6. Select both disks. Click NEXT to initialize both arrays. 

NOTE: Normally, do not convert disks to dynamic disks. The file system cannot be expanded on a dynamic disk. In this 
case it is required. 
7. After selecting both disks, click NEXT. 
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8. Click FINISH. The arrays are displayed in the Computer Management screen. 
 
 

 
 
 
 
 
 
 
 
 
 
9. Right-click the first disk. Click NEW VOLUME. 

10. Click NEXT when the New Volume Wizard opens. 

11. Click SPANNED. (This type of volume concatenates the two disks together). 

12. Click NEXT. 

13. The NEW VOLUME WIZARD opens. Choose the desired disks and the size of the resulting volume. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
14. Click NEXT. Follow the normal formatting procedure for a disk. 
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15. After the array initializes, it is displayed at the Computer Management screen. 
 
 
 

 
 
 
 
 
 
 
 
 
 
Naming Arrays 
Naming an array can be a useful practice, particularly when using RAID1n and RAID10n to perform backups. It allows an array in 

the BIOS to be easily identified. 

To name an array 
1. In the “Array View” area of the Computer Management screen, click on the array to select it. 

2. Right-click on the array to view the Array menu. Click NAME. 

3. Type the desired name in the Array Name window. 

NOTE: The specified name appears in the “Array List” and in the BIOS. 
NOTE: Names can be up to 30 characters long. However, the BIOS will display only 17 of those characters. 
NOTE: Characters not allowed in the array name are as follows: 
( 

^ 

) 

, 

| 

= 

“ 

. 
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Using LEDs to Identify Arrays 
You can use the “Identify Array” option within RAIDConsole to physically identify the disks that are part of an array. By selecting an 

array within RAIDConsole and using this feature, the LEDs on the controller or a disk enclosure blink for each disk within that array. 

If an array fails, this feature can be used to physically identify the disks that are associated with the failed array. 

Before You Begin... 
 
Issues and Recommendations for Using LEDs to Identify Arrays. 

Issues Recommendations 
LED cables If the LED cables between a disk enclosure and the controller 

are not properly connected, the wrong disks might be identified. 
Dedicated spares The LEDs for disks that are assigned as dedicated spares for an 

array do not blink. 
Source and destination 
arrays 

If the system is actively transforming or restoring an array, the 
disks associated with both the source array and the destination 
array blink. 

 

To use LEDs to identify the disks in an array 
1. In the “Array View” area of the Array Status window, select the desired array. 

2. Right-click the array to access the Array menu. Select “Identify Array”. (When the Identify window is displayed, the LEDs for the 

disks associated with that array begin to blink). 

3. To stop the LEDs from blinking, click STOP IDENTIFY. 

Transforming Arrays 
With the “Transform” option on the Array menu, an array can be transformed from one RAID level to almost any other RAID level. 

The array can be expanded dynamically, even under I/O load. In addition, with a 52-level license the Online Capacity Expansion 

(OCE) and Online RAID Level Migration (ORLM) features can be used to increase the size and organization of an array. These 

features can also be used as part of system backup and recover, by using the RAID1, RAID10, RAID1n, and RAID10n array types. 

Before You Begin... 
Issues and Recommendations for Transforming Arrays. 
 
Issue Recommendation 
Array size An array cannot be transformed to a smaller-sized array. New 

arrays must be either the same capacity or larger. 
Array size limits The array size of the transformed array is limited to 2.199 TB on 

some versions of Windows and Linux. Refer to your operating 
system documentation for details on maximum array sizes. 

Array failure If a drive fails while the transform is in progress, no data is lost 
as long as the source and destination array types are redundant. 
If a spare has been assigned to the destination array, a fail-over 
task will start as soon as the transform completes, provided the 
spare is available after the transform. 

Multiple arrays If there are multiple arrays on the controller, it might not be 
possible to transform some of the arrays to a larger size. If, in 
the future, an array needs to be expanded in size, it is best to 
configure the available space as a single array. 

Task control commands When using task control commands, a transform can only be 
paused/resumed but not removed. To end a transform task, 
pause and delete it. NOTE: If a task is paused and then 
deleted, the array will be deleted. Deleting a task is the 
same as deleting an array. Data loss will occur when the 
task is deleted. Please ensure you have your data backed 
up prior to deleting a task involving a transform or restore. 

System reboot during 
transformation 

If the system reboots during a transform, the transform 
continues where it left off. 

 
 

To transform an array 
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1. In the “Array View” area of the Array Status window, select the array to be transformed. 

2. Right-click the array to access the Array menu. Select “Transform”. 

NOTE: If the computer screen is not wide enough, only the “Destination View” is displayed. 
3. Select the RAID type to be transformed. 

4. Select all the disks that you want in the array (including disks that might already be in the array) by clicking on the box next to the 

drive in the “Disk List” area. 

5. Do one of the following: 

• To expand the array, enter the size of the new array. 

or 

• Accept the default size. 

NOTE: An array can be transformed to an equal sized or larger array. It cannot be transformed to a smaller array size. 
NOTE: If a transform is not possible, the “Commit” option is not enabled. A common reason preventing a transform is 
insufficient available space. 
6. Click COMMIT. 

NOTE: If a transformation is selected for which you are not licensed, the “License Issue” message displays. 
NOTE: Unless the transform is instantaneous, the Array Status window updates to show the source and destination 
arrays, along with the progress of the transformation. 
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6. Ordering Information 
 
OSS-MDA-T5-6TB 
Ultra-rugged, high-performance RAID storage with innovative dual removable drive packs and dual SBB 2.0 compliant high-speed 
controllers each with two Fibre Channel 8Gb/s inputs. Includes 12 x 500GB SATA-II HDD (6 HDD per drive pack). 
 
OSS-MDA-T5-12TB 
Ultra-rugged, high-performance RAID storage with innovative dual removable drive packs and dual SBB 2.0 compliant high-speed 
controllers each with two Fibre Channel 8Gb/s inputs. Includes 12 x 1TB SATA-II HDD (6 HDD per drive pack). 
 
OSS-MDA-T5-18TB 
Ultra rugged, high-performance RAID storage with innovative dual removable drive packs and dual SBB 2.0 compliant high-speed 
controllers each with two Fibre channel 8Gb/s inputs. Includes 12 x 1.5TB SATA-II SSD (6 SSD per drive pack). 
 
OSS-MDA-T5-24TB 
Ultra rugged, high-performance RAID storage with innovative dual removable drive packs and dual SBB 2.0 compliant high-speed 
controllers each with two Fibre channel 8Gb/s inputs. Includes 12 x 2TB SATA-II SSD (6 SSD per drive pack). 
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Appendix 
 
What is bcadm? 
The bcadm program is a command line tool for managing the MDA-T5 controllers.  

The bcadm program initiates RAID operations, such as: 

• Creating and transforming arrays 

• Deleting arrays 

• Adding and removing disks 

• Splitting mirrored arrays. 

It also provides information on drive and array states. In --follow mode, it logs events and notifies the administrator of any changes 

in disk or array status. 

The bcadm program has eight primary modes, with most primary modes having additional optional arguments. The eight modes of 

operation are: 

 
Modes for the bcadm Program. 
 

Mode Usage 
Manage Uses the bcadm --manage command to manage and query 

controllers, 
arrays, and disks. 

Create Uses the bcadm --create command to create a new array. 
Delete Uses the bcadm --delete command to delete arrays. 
Transform Uses the bcadm --transform command to transform an array. 
Create Copy Uses the bcadm --create copy command to create a copy of an 

existing array. 
Split Uses the bcadm --split command to split a mirrored array. 
Follow Uses the bcadm --follow command to follow or monitor arrays 

and disks. 
 
Example of bcadm Usage 
The following example steps you through a series of bcadm commands. The examples are shown in logical progression with the 

resulting output of each command. Reviewing this information will give you an idea of what to expect while working with the bcadm 

program. This scenario illustrates most of the major modes of operation and some of the more commonly used options—including 

initializing disks, creating arrays, querying for information, transforming arrays, and splitting a mirrored array. 
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bcadm Command Sequence and Their Location in This Chapter. 
 

Command 
Number 

Action Performed Page 
Location 

1 Query the status of all controllers, disks, and arrays. E-54 

2 Initialize all eight disks. E-55 

3 Query again to see the status of all controllers, disks, and arrays. E-56 

4 Create a RAID1 set the size of 1 GB using three disks, E-57 

5 Query the status of array 1 in verbose mode to get all details. E-58 

6 Query the status of the controller. E-59 

7 Create a new RAID5 set with a size of 1GB using all disks, while also enabling 
distributed sparing. 

E-60 

8 Query the status of array 2. E-60 

9 Check the activity status of array 2 and its task type. E-61 

10 Query the status of all controllers, disks, and arrays. E-62 

11 Query information on the arrays only. E-63 

12 Split array 1 using the default settings. E-64 

13 Query the status of all arrays. E-64 

14 Assign array 1 the label “old mirror.” E-65 

15 Assign array 3 the label "new split.” E-65 

16 Query again the status of all arrays. E-65 

17 Un-hide array 3. E-66 

18 Query the status of array 3. E-66 

19 Print the maximum possible size, if array 3 is transformed from a Volume to a 
RAID5 set, using all disks. 

E-67 

20 Transform array 3 to a RAID5 set using all disks, with a size of 2 GB. E-67 

21 Query the status of all arrays. E-68 

22 Query the status of all arrays. E-69 

 


